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1 INTRODUCTION 
 
1.1 ABOUT THE HIGH DENSITY FILTER 

READER 
 
Welcome to the High Density Filter Reader (HDFR).  This 

program is designed to analyze images of high-density filters.  Through 
a user-friendly, graphical interface, HDFR allows you to quickly and 
accurately identify clone locations on high-density membranes, 
quantify results for a single filter, and perform expression analyses 
between multiple filters.  We welcome your feedback and comments 
regarding all aspects of this program. 

 
 
1.2 ABOUT THIS TUTORIAL 

 
This tutorial will lead you through a step-by-step analysis of a 

sample filter image.  The role of the tutorial is to provide you with 
information about the main functions of the software and to assist you 
in analyzing your own filter images using the HDFR.  For a detailed 
description of all functions of the HDFR and further information, 
please consult the HDFR User’s Manual. 

 
Sections preceded with “Note:” offer additional information that 

may not necessarily be related to the analysis of the sample image. 
 
If you have already installed the HDFR on your computer, please 

skip to Section 3, STARTING THE HDFR, otherwise please continue 
to Section 2, SETUP AND INSTALLATION. 
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2 SET-UP AND 
INSTALLATION 

 
2.1 MICROSOFT WINDOWS 
 

To install the High Density Filter Reader on a computer 
running a Microsoft Windows operating system, place the HDFR 
Installation CD in your CD-ROM drive.  If the Autorun feature is 
enabled, the installation will automatically start.  If not, you can start 
the installation by opening My Computer, navigating to your CD-
ROM drive, selecting the Windows directory and running Setup.exe. 
 

As you move through the installation, be sure to read each 
step.  Please take the time to read the license agreement.  If you have 
questions or problems with the license agreement, please do not 
continue the installation.  Contact INCOGEN and we will help you in 
any way possible.  Once you have installed the HDFR, you can review 
the license agreement by navigating to the directory where you 
installed the software and opening the file license.txt. 
 

Once you have accepted the license agreement, you may select 
the directory into which to install the HDFR (Figure 1a). The default 
destination directory is: 

 
 C:\Program Files\INCOGEN\HDFR.   
 
If you would like to change the destination directory, press 

Browse and select a new location. 
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Figure 1a: Choosing a destination directory. 
 
 
After you have selected a location for the software, you will 

be asked to specify what type of installation you would like to perform: 
Typical, Compact or Custom.  In the typical installation, the files 
necessary for running the HDFR will be installed, as well as a set of 
sample files and an electronic copy of this tutorial.  In the compact 
installation, only the files necessary for running the software will be 
installed.  In the custom installation, you can choose which items you 
would like to install through a dialog like the one shown in Figure 1b 
below. 
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Figure 1b: Selecting the components to install. 
 
 

Finally, the installation will prompt you for a location to place 
a shortcut.  The default location is on the Start menu under Programs 
in a group called INCOGEN.  You can change this location if you 
desire.  Press Next to begin copying the files from the CD to your hard 
drive. You will see a progress meter as files are copied and your system 
is configured.  When this completes, press Finish.  The software is now 
ready to use. 
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2.2 UNIX - SOLARIS 
 

To install the HDFR onto a computer running the Solaris 
operating system, please insert the HDFR CD into the CD-ROM drive.  
The CD should mount automatically and will typically appear in the 
directory: /cdrom/hdfr.  If the CD does not mount properly, please 
contact your local system administrator.  If the problem persists, please 
contact HDFR Support at INCOGEN. 

 
 Once the CD is mounted, you should create a local HDFR 
source directory on your computer, for example: /usr/local/src/hdfr.  
Then copy the file named install.tar from the solaris directory on the 
CD onto your local system.  Once you’ve copied the file to your local 
system, use the tar command to un-tar the contents into your HDFR 
source directory.  The following example outlines these tasks. 
 

> mkdir /usr/local/src/hdfr 
> cd /usr/local/src/hdfr 
> cp /cdrom/hdfr/solaris/install.tar . 
> tar -xvf install.tar  

 
Before continuing the installation of the HDFR please verify 

that the appropriate patches have been installed on your computer.  The 
patches are needed for the Java Runtime Environment (JRE) to run 
properly.  Solaris 2.8 does not require any extra patches; however, 
versions 2.6 and 2.7 require patches as listed in the files 
README.i386 (for PC-based architecture), or README.sparc (for 
Sparc-based architecture).  The files are located in the directory 
x86_patches (PC) or sparc_patches (Sparc) inside the hdfr directory 
structure on your local system.  Table 1 shows the names of the patches 
necessary for each operating system. 
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Operating System Patch File Name 

Sparc Solaris 2.6 1.2.2_05a_patches_sparc_5.6.tar 
Sparc Solaris 2.7 1.2.2_05a_patches_sparc_5.7.tar 
x86 Solaris 2.6 1.2.2_05a_patches_i386_5.6.tar 
x86 Solaris 2.7 1.2.2_05a_patches_i386_5.7.tar 

 
Table 1: A list of the Solaris patch names for various versions of the 
operating system. 

 
 
The installation of these patches is covered in the README 

file in the appropriate directory.  After the patches have been installed 
and the system has been rebooted, you will be ready to run the HDFR 
installer.  The following steps outline this process. 
 

1. Start X windows  
2. Log in (or “su”) as root. 
3. Verify that your DISPLAY ENV variable is set up correctly. To 

check, run: 
> /usr/openwin/bin/xterm  

If a new xterm window opens up without problems, the 
display is set correctly.  (The display will not be an issue if 
you log in as root at the system prompt and your current X 
windows session will be spawned by root, but may be a 
problem when you use the “su” command to become root 
during an already existing session.) 

4. Change directory to the directory to which HDFR files were 
copied.  For example: 

> cd /usr/local/src/hdfr 
5. Run: 

> perl install.pl 
to start the installation script.  The script prompts you to 
answer questions about the destination directory and the 
location of the source tar file for the HDFR.  (The names 
shown in brackets contain the default answers.  To accept the 
default for each question, simply hit the ‘Enter’ key.)  The 
destination directory will contain the HDFR specific files and 
directories used when running the program.  The source tar 
file refers to one of the hdfr.*.tar files, which are the 
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operating system specific files extracted from the initial 
install.tar file.  The tar files in our example are contained in 
the directory /usr/local/src/hdfr.  Please submit an absolute 
path when specifying the destination directory and the tar file 
name.  After the HDFR files have been installed you will be 
prompted to start the HDFR to finalize the installation.  If the 
DISPLAY variable is not set correctly, you will see an error 
similar to: "Exception in thread "main" 
java.lang.InternalError: Can't connect to X11 window server 
using ':0.0' as the value of the DISPLAY variable".  Please 
contact your local system administrator if you cannot change 
the display to your local computer. 

6. After the HDFR has been run for the first time you will see a 
message stating that the installation is complete. You may 
now exit the HDFR and run it anytime as needed. 
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3 STARTING HDFR 
 
3.1 MICROSOFT WINDOWS 
 

If, during the installation, you chose the default location for 
placing the shortcut, you can start the HDFR by pressing Start-
>Programs->INCOGEN->High Density Filter Reader as shown in 
Figure 2.  If you chose a different location for the shortcut, navigate to 
the appropriate folder to start the HDFR.  
 

 
 

Figure 2: Starting the HDFR under Microsoft Windows. 
 
 
3.2 UNIX - SOLARIS 
 

The installation script described in Section 2.2 creates and 
places the runHDFR batch script in the directory into which the HDFR 
was installed.  Execute this script to start the program, for example: 
 

> /usr/local/hdfr/runHDFR 
 
The program can be run by any user on the system, provided that 

the appropriate read and execute permissions are granted to the user. 
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4 LOADING AN IMAGE 
 
The HDFR recognizes images of filters in the following 

formats: TIFF, GIF, JPEG (JPG).  To open a new image, you can select 
File->Open Image from the Main Menu (Figure 3a), or click on the 
Image FastFlow button (Figure 3b). 

   

 
 

Figure 3a: Opening an image by using the File menu. 
 
 

 
  

Figure 3b: Opening an image by using the FastFlow button. 
 
 

Select the directory into which you installed the HDFR.  (For 
example, the default install directory for the Windows operating system 
is: 

 C:\PROGRAM FILES\INCOGEN\HDFR2.)  
 
 That directory contains a sub-directory named samples which 

contains three sample image files: 
 

1. sample1-4x4a.jpg 
2. sample2-4x4b.jpg 
3. sample3-4x4b.tif 
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Double-click on the file called sample3-4x4b.tif to select it for 
analysis (Figure 4).  If you are running Microsoft Windows, it is 
possible that you do not see the extensions (.jpg, .tif) of the sample 
images because you enabled the “Hide file extensions” feature. 
 

 
 
Figure 4: The file chooser window with the image file sample3-4x4b.tif 
selected for analysis. 
 
 

After the image file has been selected and loaded into the 
HDFR, it will appear inside of the image panel (Figure 5).   
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Figure 5: The sample image sample3-4x4b.tif opened inside of the 
HDFR. 
 
 
 At this time, you have successfully loaded a filter image into 
the HDFR.  You can now proceed to the next step, which allows you to 
select a filter layout that corresponds to your filter. 



Tutorial 

Copyright 2001, INCOGEN, Inc. 18



High Density Filter Reader, version 3 

Copyright 2001, INCOGEN, Inc. 19

 

5 LOADING A FILTER 
LAYOUT 

 
The next step in the analysis process is the selection of the 

appropriate filter layout.  You can either use and modify an existing 
layout, or you can design a layout from scratch.  A sample layout has 
been installed with the HDFR.  To load it, select File->Open Layout 
from the Main Menu (Figure 6) or press the Layout FastFlow button. 

 

 
 

 
   

Figure 6: Importing a layout file by using the File menu. 
 
 
Again, using the system file chooser, select the samples sub-

directory inside of the directory into which the HDFR was installed and 
double-click on the file called SampleLayout.hlf (Figure 7).   
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Figure 7: Choosing the layout file SampleLayout.hlf (hlf = HDFR 
Layout File). 

  
 
Once the layout file has been loaded, the following pop-up 

window will appear: 
 

 
 

Figure 8: The layout dialog box (Filter Layout tab selected). 
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The layout window allows you to choose and modify the 
following layout parameters: 

 
1. Filter Layout  
2. Field Layout 
3. Duplication Pattern 
4. Anchor Spots 

 
Select the Filter Layout tab (it will already be selected by 

default) to bring the filter layout to the foreground.  Using the 
horizontal slider bars, you may select the number of rows and columns 
corresponding to the number of fields on the filter.  The example image 
contains a 2x3 layout.  Use the upper slider to adjust the number of 
rows to 2 and the lower slider to adjust the number of columns to 3.  
Once you have selected the correct number of fields, you may click on 
the small images of the fields to select their order.  The first field on 
which you click becomes field #1, the second becomes field #2, etc.  If 
you have mistakenly assigned a wrong number to a field, click on it 
again to erase the current number and select the correct field.  Use the 
field numbering scheme shown in Figure 8 for the image you are 
currently analyzing. 
 
 For information on filter loading protocols, see Appendix  A. 
 

Once the correct filter layout has been selected, click on the 
Field Layout tab to bring it to the foreground.  This window allows 
you to choose between a 96 and 384 well plate and choose the location 
of the A1 well.  Use the buttons to adjust your set-up to correspond to 
Figure 9. 
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Figure 9: The Field Layout dialog box. 
 
 

After selecting the correct field layout, proceed to the 
Duplication Pattern window by clicking on the corresponding tab.  
Use this window to select the appropriate gridding pattern for the filter 
image.  It is crucial to select the correct pattern.  The algorithm will not 
recognize any hits correctly if the selected pattern does not correspond 
to the gridding pattern used on the filter.  The clones on the filter in the 
example image sample3-4x4b were spotted in the pattern shown below: 

 

 
 

Figure 10: The 4x4 duplication pattern used in the production of the 
filter sample3-4x4b. 
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The duplication pattern for this image has been saved with the 
description name 4x4 b.  Select the name using the slider bar as shown 
in Figure 11.   

 

 
 
Figure 11: Selecting the appropriate duplication pattern for the filter 
image sample3-4x4b. 
 
 
 Using the “Black Hits / White Hits” radio button, you can 
select whether the image of the filter contains dark hits on a light 
background or vice versa.   
 

Note: You can also define your own gridding pattern for use 
with the HDFR.  To do so, click on the Add button to bring up the 
pattern definition window.  Pattern densities ranging from 3x3 to 8x8 
can be chosen with the slider.  After selecting the appropriate density, 
you can fill in the pattern by clicking on the fields.  Use of this 
interface is similar to the numbering of fields in the Filter Layout 
window.  (The pattern field index increments with every other click for 
use with a duplicate gridding pattern.)  For more information, please 
refer to the HDFR User’s Manual.   



Tutorial 

Copyright 2001, INCOGEN, Inc. 24

 
Anchor spots are not used in this example.  For a description 

of the Anchor Spots tab and related functionality, see Appendix B. 
 
Once you have completed the steps described in this section, 

click on the Done button to proceed to the analysis steps.  You may 
also save the layout for future use by clicking on the Save button before 
clicking the Done button.   

 
Note: When the HDFR is executed, it looks for a default 

layout file called default.hlf located in the HDFR root directory.  If 
that file is found, the layout saved in that file is used for the analysis of 
all filter images unless another layout file is loaded.  This is particularly 
useful if you analyze many filters that use the same layout.  To take 
advantage of this feature, you should save your layout file under the 
name default.hlf in the HDFR root directory.  
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6 ANALYSIS 
 
6.1 GRID PLACEMENT 
 

After the correct layout has been loaded into the HDFR, a grid 
will appear superimposed on the filter image and you will see the 
pattern you have chosen in the pattern window (Figure 12a).   
 

 
 
Figure 12a: The grid is superimposed onto the filter image sample3-
4x4b. 

 
 
You may choose between different views by selecting the Full 

Grid (Figure 12b) or the Partial Grid (Figure 12c) options located just 
right of center at the top of the HDFR window. No Grid .  The Beveled 
option offers a raised perspective (by alternating the grid cell colors) of 
the grid on the filter.  This visual aid for placing the grid is particularly 
useful when the gap between the cells is set to zero.   
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Figure 12b: The Full Grid option. 
 

 
 

Figure 12c: The Partial Grid option with the Beveled option enabled. 
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The grid can be moved into the correct position by using the 
control points (squares at the corner points of the grid and between 
some fields).  The control points can be moved with the mouse, the 
arrow keys, by entering numerical values for the coordinates into text 
fields at the top right, or by using the arrow icons next to the field 
coordinates.  Each control point can be selected by clicking on it, or, 
once a control point is selected, by hitting the spacebar to move to the 
next control point.  The spacebar cycles through the control point on 
the outside corners before selecting the inside ones.  The active control 
point will automatically come into view in the main image panel.  It 
will also be visible in the small grid alignment window to the left of the 
control points adjustment controls.  

 
Select the outside control points (a filled-in square represents 

an active and movable state) and position them such that their x and y 
coordinates correspond to the coordinates shown in Figures 13a-d. 
 

 
 

Figure 13a: The coordinates for the upper left corner are (8,15). 
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Figure 13b: The coordinates for the upper right corner are (1086, 22). 
 
 

 
 

Figure 13c: The coordinates for the lower left corner are (5, 1106). 
 
 

 
 
Figure 13d: The coordinates for the lower right corner are (1079, 1111). 
 
 
 Note:  To help accurately place the grid, you should click on a 
cell containing a positive hybridization event several cells away from 
the active corner.  The cell will appear outlined in blue and a zoomed-
in view of that cell will appear to the left of the pattern window. You 
may now use the zoomed-in view to position the grid until the 
hybridization spots are in the correct position.  You should use the 
mouse to move the grid to an approximate position and then use the 
arrow keys or the up/down/left/right buttons next to the field 
coordinates to accurately position the grid. 
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 Once the four outside corners have been positioned correctly, 
you may use the squares on the inside perimeter of the grid to adjust the 
distance between the fields.  Specify the (x,y)  coordinates for the two 
inside squares as shown in Figures 13e and 13f. 
 

 
 
Figure 13e: The coordinates for the control point which determines the 
horizontal spacing between fields are (366, 17). 

 
 

 
 
Figure 13f: The coordinates for the control point which determines the 
vertical spacing between fields are (7, 560). 

 
 
 To specify the correct gapping between cells, adjust the Gap 
controls (marked by G).  The value of the Gap should be set to 1 for 
this example.   
 
 After the grid has been placed correctly over the filter image, 
click on the Standard (standard analysis) FastFlow button (Figure 14) 
to analyze the filter.  The analysis of the filter generally takes a few 
seconds, depending on the speed of your computer.   
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Figure 14:  Starting an analysis using the Standard (analysis) FastFlow 
button. 
 
 
6.2 DATA VISUALIZATION AND 

MANIPULATION 
 

The HDFR offers users an intuitive and user-friendly way to 
browse through and manipulate the data once the filter image has been 
analyzed.  In the following sections some of those features are 
explained as they are applied to the example image.  For a detailed 
description of all features, please refer to the HDFR User’s Manual. 

 
 

6.2.1 Overview 
 

After the analysis of the filter is completed, the data will be 
presented to you in two ways.  The analysis results are displayed in a 
spreadsheet format on the left side of the image (Figure 15a) and 
hybridization events (hits) are also circled on the image itself.  You 
may use the Trace Hits option to toggle the display of identified 
hybridization events that fall above the Display Level (see Section 
6.2.2). The spreadsheet data consists of four columns.  The first column 
(ID) represents the pattern number.  The second column (Value) 
displays the confidence level of the call.  The third column (Clone) 
displays the clone name obtained from the cell address, pattern, and 
library index.  The fourth column is used to mark user input with a star.  
The value in the second column is used to determine whether the 
particular call constitutes a hit and/or whether it is displayed.   

 
To view the numerical results for a particular cell, you can 

simply click on the cell of interest.  The cell selected in Figure 15a is in 
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field 5.  Find this cell on your image and click on it.  This action has 
four effects: 1) The cell becomes highlighted in blue, 2) a zoomed in 
view of the cell appears in the zoom window, 3) the pattern for the cell 
appears in the pattern window, and 4) the spreadsheet display 
automatically focuses on the rows corresponding to the cell and 
highlights them.  You can also obtain focus of a certain cell by clicking 
on any of the columns in the spreadsheet.  For further descriptions on 
navigating between cells, please refer to Section 6.2.4. 
 

 
 
Figure 15a: The results of the analysis are displayed in a spreadsheet 
and represented on the image by circles drawn around the hybridization 
events.  The outlined cell and pattern correspond to the clone location 
35D19. 
 
 

Note: If the filter contains many irregularities, users have the 
option to execute the “advanced analysis” which is more time 
consuming, but is also more sensitive than the standard analysis which 
is executed by default.  To perform the advanced analysis, press the 
Advanced (analysis) FastFlow button.    For a detailed description of 
both analysis algorithms, please refer to the HDFR User’s Manual. 
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6.2.2 Hit Threshold and Display Level 
 

The two horizontal sliders named Hit Threshold and Display 
Level are used to control visualization of the data.  Only hybridization 
events with values greater than the current Hit Threshold slider value 
are considered true “hits” and are displayed in green.  Values that fall 
below the Hit Threshold, but are above the Display Level slider value 
are considered potential candidates for a hit and are displayed in 
yellow. Values that fall below the Display Level are not displayed.  In 
Figure 15a, the Hit Threshold was set to 0.500 and the Display Level 
was set to 0.233.  The “6” pattern in the highlighted field was assigned 
a confidence value of 0.738. It therefore falls above the Hit Threshold 
and is displayed in green.  That pattern and cell location correspond to 
the clone address 35D19. Figure 15b focuses on the cell and pattern 
corresponding to the clone 37L20.  The “7” pattern was assigned a 
confidence value of 0.361, which falls below the Hit Threshold, but 
above the Display Level and is therefore drawn in yellow to signal a 
potential hit.   
 

 
 
Figure 15b: The results of the analysis are displayed in a spreadsheet 
format and represented on the image by circles drawn around the 
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hybridization events.  The outlined cell and pattern correspond to the 
clone location 37L20. 
  

 
Note: The fastest method to set the correct threshold for a 

whole filter (which means that all of the “true” hits as deemed by the 
user are drawn in green) is to choose the weakest hybridization signal 
that corresponds to a “true” hit and to set the Hit Threshold just below 
it.  
 

 
6.2.3 Zooming 
 

There are three ways of taking advantage of the zooming 
feature.  The entire image can be magnified by using the Zoom slider. 
Also, as described in Section 6.2.1, by left-clicking on a cell, the cell 
appears magnified in the small zoom window to left of the pattern 
window.  In addition, local regions of the image can be magnified by 
clicking and holding the right mouse button on any part of the filter 
image.  A magnification of the region around the mouse pointer will 
appear and will be repainted dynamically when the pointer is moved 
until the right mouse button is released (Figure 16).   
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Figure 16: An example of dynamically magnifying a region of the filter 
by using the right mouse button. 

 
 

6.2.4 Navigation Shortcuts  
 

In addition to clicking on a particular cell of interest to obtain 
focus for it, the HDFR provides you with several shortcuts to jump 
between cells.   This allows you to quickly navigate through cells of 
interest on the filter.  After a cell has been selected and a blue outline is 
drawn around it, arrow keys in combination with control keys can be 
used to move the focus represented by the blue rectangle.  The arrow 
keys move the cursor left, right, up, or down.  Movement on the edges 
of the grid is wrapped around. The space bar has the same effect as the 
right arrow key.  The ‘Alt’, ‘Ctrl’, and ‘Shift’ keys may be used in 
combination with the left and right arrow keys to move to the next or 
previous “hit” or “miss”.  (“Next” refers to cells to the right or down, 
and “previous” refers to cells to the left, or up.)  The ‘Alt’ key indicates 
you wish to move to a hit.  The ‘Ctrl’ key indicates you wish to move 
to a miss.  The ‘Shift’ key, in addition to the ‘Ctrl’ and ‘Alt’ keys, 
means that you wish hit and miss to be determined by the Hit 
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Threshold instead of the Display Level.  Table 2 gives a listing of the 
shortcuts and their functions. 

 
Action Result 

Alt + right Move to the next cell that contains a hybridization 
event with value above the Display Level, or was 
user-defined.  (yellow, blue or green) 

Alt + left Move to the previous cell that contains a 
hybridization event with value above the Display 
Level, or was user-defined.  (yellow, blue or green) 

Ctrl + right Move to the next cell that does not contain a 
hybridization event. (below Display Level)  

Ctrl + left Move to the previous cell that does not contain a 
hybridization event. (below Display Level) 

Shift + Alt + 
right 

Move to the next cell that contains a hybridization 
event with value above the Hit Threshold, or  was 
user-defined.  (blue or green) 

Shift + Alt + 
left 

Move to the previous cell that contains a 
hybridization event with value above the Hit 
Threshold, or  was user-defined.  (blue or green) 

Shift + Ctrl + 
right 

Move to the next cell that contains a candidate 
hybridization event that falls below the Hit 
Threshold, but above the Display Level.  (yellow) 

Shift + Ctrl + 
left 

Move to the previous cell that contains a candidate 
hybridization event that falls below the Hit 
Threshold, but above the Display Level.  (yellow) 

 
Table 2: A listing of the navigation shortcuts and their functions. 

 
 
6.2.5 Local Operations and Re-analysis 
 

Sometimes it may be advantageous to keep results for specific 
areas of the filter as they are and to re-analyze the remainder of the 
filter.  This may be particularly useful when the filter contains varying 
background levels or is especially difficult to analyze.  You can use the 
‘Insert’ and ‘Delete’ keys in combination with the ‘Shift’ key to mark 
or delete hits as “committed” and adjust the thresholds or re-analyze the 
rest of the filter without affecting the marked cells.  Hits or misses that 
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were marked as “committed” based on user input are distinguished by 
an asterisk next to the clone entry in the spreadsheet view and the 
outlines of the hits are drawn in blue. Table 3 lists the keys and their 
functions. 

 
Action Result 
Insert Mark all hybridization events in the current cell 

as “committed”.  (Green and yellow are marked 
as hits.) 

Delete Delete all hybridization events in the current 
cell. 

Shift+Insert Mark hybridization events above the Hit 
Threshold (green) as “committed” and delete 
hybridization events below the Hit Threshold 
in the current cell. 

Shift+Delete Reset calls in current cell to original values. 
 

Table 3: The shortcut keys and functions for marking calls in individual 
cells as “committed” for further re-analysis of filter. 

 
 

6.2.6 User Calls 
 

An additional option for the user to manipulate the results is to 
change the call to a different pattern than the pattern obtained by the 
algorithm.  As an example, select the clone 37L20 by either clicking on 
the filter image, or the corresponding row in the spreadsheet (Figure 
17).  By clicking on it, a zoomed-in view of the filter and the 
corresponding hit appears in the upper part of the HDFR.  
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Figure 17: Selecting a detailed view of the clone 37L20. 
 
 
 Let us assume that the hit was really a “5” rather than a “7”.  
To change it, first click on one of the “7”s in the small pattern window 
and then click on one of the “5”s.  Changing a hit has the following 
four consequences (Figure 18): 
 

1. The hit pattern changes from a “7” to a “5” pattern in the 
pattern window. 

2. The small circles in the filter image turn blue to indicate user 
input. 

3. The clone entry corresponding to the “7” pattern in the 
spreadsheet disappears and the row is marked with an asterisk 
in the last column to indicate user input. 

4. A clone entry corresponding to pattern “5” is added in the row 
corresponding to that pattern and the row is marked with an 
asterisk to indicate user input.  
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Figure 18: User-initiated change in the hybridization pattern. 
 
 

By clicking on the Reset button (Figure 19) the user input can 
be reset for the highlighted cell only.  (This operation is equivalent to 
the ‘Shift+Delete” shortcut.)  To reset all user-initiated changes for the 
entire filter, click on the Reset All button. 

 

 
 

Figure 19: Resetting the results for a single cell.  
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6.3 QUANTIFICATION OF 
HYBRIDIZATION EVENTS 

 
You can quantify the level of hybridization events, by selecting 

Quantify Results from the Data menu (Figure 20).   
 

 
 

 
 
Figure 20: Quantifying the hybridization events by selecting Quantify 
Results from the Data menu.  
 
 

After a few seconds, during which the quantification analysis 
takes place, you will notice that HDFR has switched to the 
Quantification mode.  You can move between the previous, clone 
address identification screen, and the quantification screen by clicking 
on the Screening / Quantification tabs in the lower left corner (Figure 
21). 
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Figure 21: The Quantification screen. The cell containing the clone 
21F15 is selected.   
 
 

The quantification mode contains several new or different 
features not found in the clone address identification (Screening) 
mode.  The following paragraphs describe those features.  

 
Magnification window 
Click on the clone 21F15 either in the table or on the cell 

containing the clone on the filter, as shown in Figure 21.  The 
magnification window now contains a traced outline view of the hit 
within the selected cell.  There are several numbers next to the 
magnification screen: the Clone name; the Intensity of the hit; the 
Deviation, or difference between the intensities of each of the colonies 
within the duplicate hit; and the Variance for all pixels in the cell.  
Pressing on the Hide button temporarily hides the filter image from 
view (this becomes useful in Section 6.4, Expression Analysis 
Between Filters) while pressing the Remove button permanently 
removes the filter from the current analysis.  (The image is not removed 
from the hard disk; it can be reloaded and re-analyzed.)  When the 
filter image is hidden, the Hide button label is changed to Show.  
Pressing Show restores the view of the image. 
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Tabular Data View  
The data view in the left panel summarizes the clone names 

(Clone), intensity values (Value) and deviations (Dev) for all hits.   
 
Bar Chart  
The bar chart located in the upper right corner gives a visual 

representation of the intensity of the selected hit.  It is particularly 
useful when comparing hits from multiple filters.  This functionality, as 
well as the numbers and radio buttons next to the bar chart, will be 
described in detail in the next section.   

 
Threshold Sliders 
The function of the threshold sliders will be explained in the 

next section. 
 
 
6.4 EXPRESSION ANALYSIS BETWEEN 

MULTIPLE FILTERS 
 

Let us now analyze a second filter and perform a quantification 
of the hits on the filter.  To do so, press on the Screening tab in the 
lower left corner.  Pressing on the tab will return you to the clone 
address identification mode (Figure 22). 
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Figure 22: Returning to the clone address identification screen.   
 
To load another image, click on the Image FastFlow button, or 

open the File menu and select Open Image.  (If you encounter 
problems during the next several steps, please refer to Section 4, 
Loading an Image.)  You will be prompted whether you wish to 
discard the clone address identification results for the current image 
(Figure 23). 

 

 
 

Figure 23: The user is prompted whether to discard existing results 
before loading a new image. 
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Select Yes and load the image named sample2-4x4b.jpg using the 
file chooser. 

 
Activate the grid by clicking on the Position Grid FastFlow 

button and place the grid control points in the positions shown in the 
table below and set the inter-cell gap to 1 by using the gap adjustment 
controls. 

  
Control Point 

Position 
Coordinates 

(x, y) 
Upper left (14,11)  
Upper right (1100, 11) 
Lower left (15, 1093) 
Lower right (1098, 1090)  
Horizontal spacing (375, 11) 
Vertical spacing (15, 552) 

 
Table 4: Grid control point positions for filter image sample2-4x4b.jpg. 
 

Perform the standard analysis by clicking on the Std. Analysis 
button. The HDFR screen should look similar to Figure 24. 
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Figure 24:  Clone address identification for filter image sample2-
4x4b.jpg. 
 
 

Set the Hit Threshold and Display Level sliders to 0.530 to 
eliminate the false negatives.  The screen should now look similar to 
Figure 25. 
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Figure 25: Clone address identification for filter image sample2-
4x4b.jpg. 
 
 

Next, select Quantify Results from the Data menu to perform 
a quantification analysis on this filter image. You will be prompted to 
provide reference clones to normalize the two filters.  Using reference 
clones to normalize filter images when comparing two or more filters is 
necessary to compensate for variations in intensities due to different 
exposure times or other factors that may lead to differences in clone 
intensity values that are not based on differences in expression levels.  
Select the clone 41M11 as the reference clone by highlighting it in the 
left panel and clicking the Add button (Figure 26).  Then click OK.    
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Figure 26: Selecting reference clones to normalize the intensity of 
filters used for expression analysis.  
 
 

Note: if you don’t know the name of the reference clone, you 
can locate the clone on the filter and click on it to highlight it in the list.  
Then simply press Add to designate it as a reference clone.  If the clone 
of interest is not the only clone in the cell, the clone with the lowest 
duplication pattern number will be highlighted. 
 

You will see the quantification screen with a split-panel view 
displaying both filter images.   Beneath the reference clones panel, 
click on the Results tab to view the numeric comparisons of the clones 
on the two filters.  Click on the clone 21F15 in the table to see it 
highlighted on both of the filter images (Figure 27). 
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Figure 27: Comparing expression levels between two filters using filter 
image 1 (sample3-4x4b.tif) as the control.   
 

You will notice that there are now two magnification windows 
displaying the highlighted cell from each filter.  Clones on the filter that 
was chosen as the control are all highlighted in yellow.  On the sample 
filter, clones outlined in green signify a lower normalized intensity 
value than the control (down-regulation) and clones outlined in red 
signify a higher normalized intensity value than the control (up-
regulation).  The bar chart in the upper right corner provides a visual 
representation of the relative expression levels.  The numbers next to 
the bar chart give the intensities as well as the ratios of the expression 
levels.  By clicking on the radio buttons next to the bar chart, the filter 
image that is used as the control can be switched.  The first filter was 
chosen as the control by default.  To select the second filter as the 
control, simply click on the radio button next to Value 2. You will 
notice that all clones on the image of the second filter (sample2-
4x4b.jpg) will become outlined in yellow (control) and that the clones 
on the image of the first filter (sample3-4x4b.tif) will become outlined 
in red or green, depending on whether they were up- or down-regulated 
(Figure 28).     
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Figure 28: Comparing expression levels between two filters using filter 
image 2 (sample2-4x4b.jpg) as the control.   
 
 Note: When a cell contains multiple hits, values for the first 
pattern that corresponds to a hit are shown by default.  To obtain values 
for a different hit pattern within the same cell, click on the 
corresponding pattern in the duplication pattern window, the cell 
magnification window, or select it from the table. 
 
 Threshold Sliders 

Using the sliders to the left of the magnification windows, you 
can adjust the thresholds for drawing the clones in green or red.  If, for 
example, you only wish to see clones that were up- or down-regulated 
by a factor of two or greater outlined in red and green, you can slide 
both sliders to the 2.0 position.  Only clones that were up- or down-
regulated by a factor of two or greater will be outlined in red or green.  
All clones with up- or down-regulation factors greater than 2.0 will be 
drawn in yellow (Figure 29).  
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Figure 29: The Threshold slider can be used to only view the green/red 
color-coding for clones above and below a certain expression ratio.  
 

Re-normalizaton  
In the described example, all intensity values were normalized 

with filter image 1 as the base.  The filters can be re-normalized with 
filter image 2 as the base by selecting Normalize from the Data menu 
and selecting filter image 2.   You will be prompted to enter the 
reference clones again. 
 
 Up to four filter images can be viewed simultaneously in the 
quantification screen by repeating the steps outlined in this section.  If a 
fifth filter image is loaded for quantification, the first image is 
removed.  
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7 DATA EXPORT 
 
NOTE: The data export functions have been disabled in 
the demo version of HDFR. 
 
7.1 STANDARD – CLONE ADDRESS IDs 
 

Once you are satisfied with the screening results as they 
appear on the filter, you may press the Results FastFlow button to 
export the data (Figure 30).  Be sure you are in screening mode; 
otherwise, you will export quantification results (see Section 7.2). 
 

 
 
Figure 30: Exporting clone address identification results by clicking on 
the Results FastFlow button. 
  

The following window will appear (Figure 31): 
 

 
 

Figure 31: The filter information dialog box. 
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This window allows you to enter the name of the library, the 

filter labeling scheme, the filter number, and the probe name.  For this 
example, call the library SampleLibrary, select Numbers as the filter-
labeling scheme, choose the number of the filter to be 1, and call the 
probe name SampleProbe.  Click OK to proceed to the next window 
(Figure 32). 
 

 
 

Figure 32: Dialog box to choose various data export options. 
 
 
 This window allows you to choose the output format of the 
data.  The first option, when checked, includes the library name as the 
first line of the results file.  The second option allows you to choose 
whether to export only clones that were marked by the user (blue) and 
clones that fall above the Hit Threshold (green), or whether to also 
include clones that fall below the Hit Threshold but above the Display 
Level (yellow).  The third option puts quotation marks around the 
clones and probes to facilitate import into MS-Excel and other 
spreadsheet programs; otherwise, a clone name such as 37E24 may be 
interpreted as a number in scientific notation: 37*1024. 
  

Note:  When importing an HDFR results file into MS-Excel, 
be sure to set the column data format of the first column to text. 

 
Clicking the OK button allows you to proceed to the file 

chooser screen (Figure 33).  This screen allows you to choose the 
directory and the name of the file to which you would like to save the 
results.  Select the samples directory and choose the file name 
sampleResults.txt. 
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Figure 33: The file chooser for data output. 
 
 

 Once the data has been saved, you may view and manipulate it 
using any text editor.  Figure 34 shows an example of viewing the data 
in the Windows operating system using MS Notepad.  
 

 

 
 

Figure 34: Viewing the exported data in MS Notepad. 
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7.2 STANDARD – QUANTIFICATION 
DATA 

 
To export quantification data, press the Results FastFlow button 

(Figure 35) when you are in quantification mode.   
 

 

 
 
Figure 35: Exporting quantification results by clicking on the Results 
FastFlow button.  
 
 The following window will appear (Figure 36):  
 

 
 

Figure 36: The quantification data export options. 
 
 By default, the exported quantification values will be those 
that have been normalized using the reference clones.  To export the 
raw values before normalization, select the “Not Normalized” option.  
The “Clones Quoted” option is identical to the corresponding option for 
exporting clone address identification data.     
 

After saving the data, you can view it using any text editor.  
The quantification data is exported in tab-delimited format.  The first 
column gives the clone addresses.  The next pair of columns gives the 
intensity values and the standard deviations for filter image 1, the 
subsequent pair of columns gives the intensity values and the standard 
deviations for filter image 2, etc.  (Figure 37)    
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Figure 37: Quantification results for two filter images viewed in MS 
Notepad.  The first column gives the clone addresses, the second and 
third column give the intensity values and the standard deviations for 
filter image 1, respectively, the fourth and fifth column give the 
intensity values and the standard deviations for filter image 2, 
respectively.   
 
 
7.3 RE-ARRAYING 
 

In addition to exporting the data in the previous format, it can be 
exported directly for re-arraying using the Genetix Q-bot.  To export 
the data for re-arraying, select Data->Export Re-arraying Data from 
the toolbar, as shown in Figure 38.  

 

 
 
Figure 38: Using the Main Menu to select the Export Re-arraying 
Data option. 
 

The following window (Figure 39) allows you to enter 
comments and/or bar codes for the plates containing the clones spotted 
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onto the filter.  You can use the slider bar to choose the number of the 
plate for which you would like to enter information.  This window also 
allows you to decide whether to apply the Display Level or the Hit 
Threshold to the exported clones.  The Hits / Misses pull-down menu 
allows you to decide whether to export all clones with positive 
hybridization events, or all clones that were “missed” by the probe.     

 

 
 

Figure 39: Adding comments, bar codes and choosing parameters for 
the re-arraying file. 
 
 After clicking OK, you can select the location and name of the 
file to which you would like to save the data.  Once the data has been 
saved, you can view and further manipulate it, or use it directly with the 
Genetix Q-bot.  Below is an example of the output file viewed in MS 
Notepad (Figure 40).  

 

 
 

Figure 40: An example re-arraying file. 
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8 SUMMARY 
 

By following the example in this tutorial you should have 
obtained a working knowledge of all essential functions of the HDFR.  
This information should allow you to use the program to analyze 
images of your own high-density filters.  If you have any additional 
questions regarding the HDFR, or would like to comment on the 
program, please do not hesitate to contact INCOGEN by phone at 800-
286-6599 or email hdfr@incogen.com.  We hope you will enjoy using 
the HDFR and will find it helpful in your research.  We look forward to 
your feedback! 
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9 APPENDIX A – ANCHOR 
SPOTS 

 
Some laboratory protocols provide for the inclusion of anchor 

spots to aid in the placement of the grid for analysis.  Anchor spots can 
be extraordinarily helpful in this way.  However, it may not be 
desirable to have those spots included in the analysis or results.  HDFR 
provides an easy mechanism for specifying the locations of the anchor 
spots, and will not include them in the analysis.  When defined, the 
anchor spots will be traced in red and signified in the results table by 
the capital letter ‘A’ as shown in the figure below. 

 
 

 
 
Figure A1:  Anchor spots are outlined in red on the image and 
represented by the letter ‘A’ in the table. 
 

Anchor spots are saved in the layout and are therefore defined 
through the Layout Editor (Section 5).  The rightmost tab on the Layout 
Editor is for defining anchor spots, as shown in Figure A2 below. 
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Figure A2:  The anchor spots tab of the Layout Editor.  On the left is 
the filter grid; in the middle, the field grid; on the right, the cell grid. 

 
On the left is a small representation of the filter, with the 

dimensions specified on the Filter Layout tab of the Layout Editor.  The 
top left field is selected by default.  This field is represented in the 
middle by a large grid of small boxes; it has either 96 or 384 cells 
depending on the selection on the Field Layout tab.  The top left cell is 
selected by default.  This cell is represented on the right by a small grid 
of small boxes; this grid has the same dimensions as the duplication 
pattern selected on the Duplication Pattern tab.   

 
Note:  Changing the dimensions of the filter, field, or duplication 

pattern on the other tabs will cause any selected anchor spots to become 
invalid. 

 
To set the top left spot of the top left cell of the top left field on 

the filter as an anchor spot, the user would click on the top left field in 
the filter representation on the left, then click on the top left cell in the 
field representation in the middle, then click on the top left box in the 
cell representation on the right.  The box in the cell grid will turn red, 
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showing that it has been selected as an anchor.  The cell in the field 
grid will display an asterisk (“*”), showing that it contains an anchor 
spot. 

 
To remove that spot from the set of anchor spots, the user must 

only click on it again in the cell grid.  The box in the cell grid will 
revert to white.  If no other boxes in the cell were selected as anchor 
spots, the asterisk will be removed from the cell in the field grid. 

 
To remove all spots from a particular cell, the user can click on 

the cell of interest in the field grid.  The asterisk will be removed and 
all boxes in the cell grid will revert to white. 

 
If all fields contain an anchor spot in the same position of the 

same cell, the user can select “Apply to all fields” before selecting the 
anchor spot.  With this option selected, all choosing and removing of 
anchor spots will apply to all fields on the filter, not just the current 
field.  

 
An individual field can be completely cleared of anchor spots by 

pressing Reset when the field is selected in the filter grid and “Apply to 
all fields” is unchecked.  All fields can be reset by pressing Reset when 
“Apply to all fields” is selected. 

 
Anchor spots will be saved in the layout whenever the layout is 

saved and reloaded the next time the layout is opened.  Refer to Section 
5 for more information about saving and opening layouts. 
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10 APPENDIX B – FILTER 
LOADING PROTOCOL 
 

Two popular ways of gridding samples onto a filter are supported 
by HDFR.  The default method is cyclic and the second method is 
consecutive.  The choice of loading protocol impacts the names 
assigned to clones during analysis.   

 
The example in this tutorial uses a filter with six fields, designated 

on the filter as shown in figures B1 and B2 below, and a 4x4 
duplication pattern.  Using this layout, the filter can accommodate 48 
plates.   

 
In cyclic loading, each field in order is gridded with samples from 

an individual plate in each cycle.  In the first cycle for this example 
filter, all pattern 1 positions on field 1 are loaded with samples from 
plate 1, pattern 1 positions on field 2 with samples from plate 2, and so 
forth.  In the second cycle, all pattern 2 positions on field 1 are loaded 
with samples from plate 7, pattern 2 positions on field 2 with samples 
from plate 8, and so forth.  Using cyclic loading, the configuration of 
the example filter is shown below.  Each field lists the plates from 
which its samples would be taken and the corresponding patterns the 
samples would fill.   
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Figure B1:  An example of a six-field filter with a 4x4 duplication 
pattern gridded using the cyclic loading method. 

 
To select cyclic loading as the method for a filter, simply choose 

“Cyclic Loading” under Filter Loading Protocol on the Filter tab of the 
Layout Editor.  Please see Section 5 for a description of the Layout 
Editor.  The loading protocol selection will be saved as part of the 
layout. 

 
In consecutive loading, each field is gridded with samples until it 

is completely filled before loading of the next field commences.  For 
consecutive loading of the example filter, field 1 would be loaded as 
follows:  all pattern 1 samples will be taken from plate 1, pattern 2 
samples from plate 2, pattern 3 samples from plate 3, and so forth.  
Field 2 for this example will fill patterns 1-8 with samples from plates 
9-16, respectively; field 3 samples will come from plates 17-24.  The 
example filter would be filled as shown below using the consecutive 
loading protocol. 
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Figure B2:  An example six-field filter with a 4x4 duplication pattern 
gridded using the consecutive loading method. 

 
To select consecutive loading as the method for a filter, simply 

choose “Consecutive Loading” under Filter Loading Protocol on the 
Filter tab of the Layout Editor.  Please see Section 5 for a description of 
the Layout Editor.  The loading protocol selection will be saved as part 
of the layout. 

 


